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ABOUT VERSION 3.5.1 

 
Revisions included in Version 3.5.1 include those to the text, and: 
 
• In the Summary Report, under ‘Mine Activity Category’ -  ‘Area Disturbance’, a 

second specialized worksheet has been added to the previous Master Worksheet.  
This is the Resloping Worksheet - for documenting cost of resloping waste dump 
faces. 

 
• In the Summary Report, under the category of Lump Sum Items, the formula missing 

in Optional Item 7 has been included.   
 
• In the Resloping Worksheet two rows have been deleted:  ‘Recontouring’ and 

‘Ripping’. Cells in Resloping Worksheet are directly linked to the Summary Report. 
 
• In the Lump Sum Items Worksheet, Part ‘A’ has been changed to include ‘Capital 

costs to closure’. Cells are directly linked to the Summary Report. 
 
• In the Post Closure Worksheet, Part ‘B’ has been retitled ‘Non ARD Operating 

System’. Cells are directly linked to Summary report. 
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• Two new worksheets have been added.  (1) ARD Capital Cost cells are directly 
linked to Lump Sum Worksheet and Summary Report. (2) ARD Operating System 
Cost cells are directly linked to Post Closure Worksheet and Summary Report. 
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1.0 INTRODUCTION 
 
Estimating cost of mine reclamation in British Columbia is made more challenging by 
mountainous terrain and the complexity that exists in the natural environment.  Despite 
this, costing can be made more efficient through definition of common categories of mine 
activity and reclamation prescription, and through their presentation and analysis on a 
spreadsheet. 
 
The spreadsheet which is described in these pages facilitates estimation of the cost of 
reclamation that remains outstanding at that specific point in time that is chosen by the 
estimator.  Often, this is set to coincide with the date of the current annual reclamation 
report. 
 
The spreadsheet also facilitates estimation of costs that may exist in the future; for 
example to support an application for mine approval under Part 10.1.2(6) of the Mines 
Act - Health, Safety and Reclamation Code.  In determination of the “... total costs of 
outstanding reclamation over the planned life of the mine ...”, certain assumptions must 
be made as to the scope of gross disturbance that will be caused by the mine, and how 
this will be reduced by ongoing reclamation.  Forecasting the pattern of future cost is 
simplified through estimating outstanding liability at a few critical stages in the life of the 
mine, as discussed in Part 2.  An important aspect here is the determination of maximum 
cost of outstanding reclamation, and the time when this will occur. 
 
The use of spreadsheets by mining companies in B.C. is now commonplace.  An 
excellent and recent treatment was presented by Highland Valley Copper, (R.W. Graden), 
at the 1996 Annual B.C. Mine Reclamation Symposium in Kamloops.  It is included in 
the proceedings, and is available from BiTech Publications in Vancouver.  Highland 
Valley Copper’s system integrates reclamation costs with overall mining costs, a step 
which hopefully can be added to future editions of this discussion. 
 
 
2.0 PATTERN IN COST OF RECLAMATION OVER LIFE OF MINE 
 
Differing and justifiable answers exist for costing questions posed on any given site.  
These will depend on such things as:  whether the objective is to determine cost to the 
mining company, or to government; or whether work is to be done during life of mine or 
in premature closure. 
 
These questions are best examined within the context of the pattern of cost that will 
develop over life of mine - as illustrated by imaginary mine in Figure 1 - a simple case in 
which all areas of surface disturbance are reclaimed at closure, and no post closure 
expenses occur. 
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2.1 Aggregating Outstanding Cost Over Life of Mine
 
At start of mining, (construction of roads and clearing of plant site, pit and dump areas), 
the rate of surface disturbance is high.  However, the unit cost of reclaiming this type of 
work is relatively low (usually in the order of $1500 per ha), and it may or may not be 
true that the backlog of reclamation increases as steeply as shown in the upper curve of 
the top diagram of Figure 1.  This top curve might equally be called ‘Aggregate (or 
Gross) Outstanding Reclamation Cost’. 
 
End of construction and start of production will likely see a change in the rate of 
disturbance.  Further change will occur as the mining plan adapts to new market 
conditions, technology and geological knowledge.  The outstanding cost curve may reach 
a plateau as closure approaches and stockpiles are drawn down and run through the mill. 
 
2.2 Ongoing Reclamation and Outstanding Cost
 
In Figure 1, the lower curve of the upper diagram sums ongoing reclamation 
expenditures.  At startup, an initial surge of reclamation activity is indicated (e.g. seeding 
of new road shoulders, borrow pits and plant areas).  Following this, annual expenditures 
may stabilize until significant dump or pit areas become inactive and available for 
reclamation.  The liability posed by outstanding reclamation at any point in time is the 
difference between the upper and lower curves - shown in the middle diagram of 
Figure 1. 
 
Although it is tempting to equate increasing area disturbance with liability, two 
exceptions exist:  wraparound berms; and valley fills.  The former are constructed against 
lower sections of high dumps, and reduce effective height of dump, and therefore cost of 
resloping, as this varies exponentially with height.  Valley fills may be constructed on 
rock drains to extend between opposing mountain flanks with similar effect (see Note in 
Section 3.3).  A concern here is that the mine may close prior to completion of the fill. 
 
Operations which are able to close out discrete areas of surface work during life of mine 
hold an advantage over those that cannot, being able both to reduce outstanding cost, and 
gain in reclamation experience during life of mine.  Reclamation done concurrently with 
mining enjoys several cost advantages: 
 

• equipment - may be switched back and forth between mining and reclamation 
• trained personnel 
• supervision 
• power 
• communications 
• staff support (accommodation and catering). 
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FIGURE 1:   RECLAMATION COST RELATIONSHIPS
(ARD Costs Not Included)
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A full discussion of cost of outstanding reclamation would consider a third curve, (not 
shown), in the top diagram of Figure 1, to represent ‘Area Available for Reclamation’.  
Development of this data will provide the mine with a statistical measure of reclamation 
performance through comparison of the area that has become available for reclamation, 
to that which has actually been reclaimed. 
 
A cost plot for an annual reclamation program is shown in the lower diagram of Figure 1.  
This is the plot of annual costs shown in aggregate in the upper diagram.  The annual 
record of cost is most useful in determining future program budgets. 
 
Developing future budget requirements from cost data requires input from a variety of 
specialists, and this is sometimes complicated by the many ways in which budgets may 
be allocated between functions. 
 
2.3 Allocating Costs 
 
Spreadsheets typically document cost of works including equipment (all found), materials 
and labor.  These are sometimes called direct costs.   
 
Part 10.1.2.(6) of the Health, Safety and Reclamation Code for Mines in British Columbia 
also requires estimation of “... costs of long term monitoring and abatement ...”.  This 
refers particularly to costs of remediating acid drainage. 
 
Overhead costs (generally considered to include administration, management, 
supervision, and research) are essential to completing works.  Total overhead costs for a 
mine which goes to planned completion will differ from one that does not.  In premature 
closure, reclamation must be done as expeditiously as possible, for delay will increase 
disturbance of vegetation that may have re-established on the site.  The period during 
which overhead costs may be accumulated is thereby reduced. 
 
When the Province undertakes reclamation work, unit equipment rates set out in the 
“Province of British Columbia B.C. Hydro and Power Authority and B.C. Rail Ltd. 
Equipment Rental Rate Guide” apply.  These tend to be higher than ‘in house’ costs 
experienced by mining companies - a reason to maximize ongoing reclamation further to 
those noted in Section 2.2. 
 
Finally, there is the question of quality of program that can be provided under conditions 
of default, as opposed to during life of mine.  This cannot be addressed in this short 
presentation, but an argument exists for establishing priority for specific works to be 
done in a future default situation. 
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Table 1:  CATEGORIES OF MINE ACTIVITY 
 
 
‘AREA DISTURBANCE’ CATEGORY 
 
RESLOPING WORKSHEET 
• Dump face resloping 
MASTER WORKSHEETS 
• Dump faces at angle of repose 
• Dump tops (the horizontal surface of dump tops, platforms, and benches) 
• Pits 
• Settling ponds 
• Tailings dam(s) 
• Tailings beach 
• Roads 
• Plant Site 
• Administration area 
• Cleared area 
 
‘LUMP SUM ITEMS’ CATEGORY 
• Mill building 
• Administration building 
• Mill 
• Silos 
• Structures 
• Power lines 
• Pipe lines 
• Conveyor 
• Stockpiles 
• Sealing of openings 
• ARD capital costs 
 
‘POST CLOSURE’ CATEGORY 
• ARD Operating System 

Plant 
Monitoring  
Other 

• Non ARD Operating System 
 Operating  
 Maintenance 
 Monitoring 
 Engineering 
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3.0  CONCEPT AND USE OF SUMMARY REPORT AND WORKSHEETS 
 
The individual worksheets which together form the workbook are shown schematically in 
Figure 2, “RECLAMATION COST ESTIMATING WORKBOOK.” 
 
In previous versions, the text included an Example Mine to demonstrate use of the 
spreadsheet, but this is now felt to be redundant. 
 
3.1 The Summary Report 
 
Use of the spreadsheet system begins with entry of project name, reclamation permit 
number and costing year in the Summary Report. 
 
The Summary Report lists three basic mine activity categories: 

• Area Disturbance (all costs which can be estimated on a $/ha basis) 
• Lump Sum Items 
• Post Closure Costs 

Some sub-categories which might be used under the above headings are suggested in 
Table 1. 
 
A new worksheet is automatically “set up” for each disturbance category as it is 
entered in the Summary Report.  The Summary Report is linked to the other 
Worksheets, and data entered on the latter automatically appears on the former, where 
this is common. 
 
3.2 Area Disturbance Category 
 
After determining the various categories of area disturbance that exist at the mine, the 
user will enter data on these in the appropriate columns of the Summary Report:  ‘total 
disturbed’, ‘permanent disturbance’ (pit walls, future permanent access roads, etc.) and 
‘current reclaimed’ (area reclaimed to date).  The program automatically calculates area 
‘to be reclaimed’.  It is left to the user to decide whether reclamation is complete or not.  
It was previously required that vegetation be established for a period of one year before 
completion could be claimed, but this prevented maintenance of a current cost record.  
Data on unit cost of reclamation prescription can be entered on the worksheets. 
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Figure 2: RECLAMATION COST ESTIMATING  WORKBOOK
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Figure  3: COST OF RESLOPING A WASTE DUMP
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3.3 Resloping Worksheet 
 
A special Resloping Worksheet was developed for the more complex estimating 
procedure required for resloping of waste dump faces. 
 
Cost increases exponentially with dump height, and also varies with such things as 
foundation slope, bulldozer size, type of blade and skill of operator.  The cost per hectare 
for resloping various heights of dump given in Figure 3 “Cost of Resloping a Waste 
Dump Face” have been drawn, over the years, from several company sources.  Although 
this data reflects past costs and should be used with care, it is felt to be the most accurate 
depiction of the relationship that exists at the lower end of the cost curve. Resloping 
dumps less that 10 meters in height is considered ‘recontouring’, to differentiate this from 
higher dump work where height has major effect. 
 
The 1984 publication “Estimating Dozer Production for Waste Dump Resloping” by the 
Alberta Coal Mining Research Centre, and “A Practical Guide to Resloping of Waste 
Rock Dumps” by Golder Associates, Vancouver, also provide good guidance. 
 
Specific dump heights shown in Column E have not been locked, so that they may be 
edited to reflect specific site requirements. 
 
3.4 Master Worksheets 
 
Standard or “Master” worksheets serve for all types of area disturbance except resloping.  
Each sub-category of area disturbance has its own Master Worksheet.  Only one Master 
Worksheet is included in Appendix 1.  The same principles that guide the Resloping 
Worksheet apply to the Master Worksheet. 
 
3.5 Material Summary Report 
 
This is located at the bottom of each worksheet, and provides: 

• a tabulated summary of costs for materials only; 
• the total cost for materials for each item. 

 
Although it is electronically linked to worksheet Sections B and C, totals developed here 
are not added directly to the Summary Report.  To illustrate, entering data in the 
worksheet column headed ‘area’ and ‘application rate’ in the row headed ‘seed’ in the 
worksheet, automatically updates ‘No. of kg’ on both worksheet and material summary 
report.  Then, entering data on ‘unit cost’ in the material summary completes the 
‘subtotal’ for this item on the material summary.  If this is followed by entry of estimated 
cost per ha. for application under ‘Applic. cost’ column in part B, the program 
automatically calculates both cost of the prescription per ha (materials plus application) 
and the subtotal for the area. 
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If the user includes additional materials in Sections B or C, these items and the associated 
unit costs should be added to the material summary report in the appropriate spaces 
provided.  Formulas have been included in Sections B and C corresponding to the 
selections of “optional-material 1 ... optional-material 4, and optional-material 1 ... 
optional main.material 1 ... optional main.material 2.” 
 
The user should be careful to match any additional entries in the worksheet with the 
material summary report. 
 
3.6 Lump Sum Items 
 
Costs entered in the Lump Sum Items Worksheet are defined as those not related 
directly to an area of disturbance.  The user will first enter sub-categories appropriate to 
the particular mine site.  The sub-category ‘Hauling surfacing material’ is included here 
because the total depends largely on volume and haul distance, not area of surface that is 
covered.  Salvage value will not be deducted from the cost of decommissioning facilities, 
even if this value exceeds decommissioning costs, because the government may not be 
first in lime in the list of creditors to claim the assets in case of default.  Also, Version 
3.5.1 includes capital cost of ARD treatment in Part A of this worksheet. 
 
3.7 Post Closure Worksheet 
 
The Post Closure Worksheet lists those costs which constitute a stream of expenses 
extending more than five years beyond closure.  Although both to closure and post- 
closure operating costs for ARD treatment are included in this worksheet, capital costs 
are included in the Lump Sum Items worksheet in order not to conflict with costing of 
present value.  Non-ARD operational and monitoring costs are added to obtain the annual 
total, upon which present value is calculated.  Entering this in the Post Closure 
Worksheet automatically updates the Summary Report. 
 
When determining costs related to ARD, it is useful to bear in mind that these will in all 
likelihood differ significantly from those of the operating period, when the surface was 
being actively disturbed.  Also, the company’s method of cost accounting in the post 
mining period may differ from that used when mining was active. 
 
3.8 ARD Capital Cost Worksheet 
 
The ARD Capital Cost lists those costs which are incurred to neutralise the effects of 
ARD. Items pertaining to the costs of developing a treatment plant and system, including 
the cost of equipment and direct and indirect costs, are tabulated on this worksheet. ARD 
treatment plant and system costs are added to obtain the total capital cost. Completing 
this  worksheet automatically updates the Lump Sum Items Worksheet.
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3.9  ARD Operating System Cost 
 
Costs entered into the worksheet titled ARD Operating System Cost include those  
costs to operate the ARD Treatment Plant, the Treatment System, along with monitoring 
and other associated costs. The totals of these costs are automatically tabulated and 
linked to the Post Closure Worksheet. 
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4.0 SOME SPECIFICS ON THE PROGRAM 
 
The following sections will provide the user with basic instructions in use of the 
computer program.  These are also to be found in the workbook format and the 
worksheets and summary report contained within the workbook.  This application 
requires that the user have some basic understanding of the Excel program.  For detailed 
instructions regarding specific Excel functions and options, the user is referred to the 
Excel manual. 
 
4.1 Document Protection 
 
Certain cells on the worksheet and summary report have been protected so that the 
contents and formulae may not be changed.  The protected cells are "locked," and the 
user will not be able to alter or format these cells.  Cells requiring data input are not 
protected and the user will be able to enter data pertaining to areas requiring reclamation 
activities.  On each spreadsheet, the cells available for data entry by the user are indicated 
by colour (gray shading - Excel version 4.0, yellow shading - Excel version 5.0) to 
provide the user with a "road map" to data entry on the spreadsheets. 
 
Because the document is protected, certain menu options will not be available to the user 
of the spreadsheet; menu options that are no longer available will appear in gray tones on 
the menu.  Should additional changes/edits be required to the spreadsheets, a password is 
necessary to edit protected cells.  Because changes could potentially affect formulae and 
document links, the requested revisions should be directed to the ministry staff member 
responsible for the password and spreadsheet revisions. 
 
4.2 Spreadsheet Features 
 
Several special Excel features have been utilized in the spreadsheets to enhance the 
"user-friendliness" of the application.  These features include:  notes in cells, document 
protection, headers and footers, and document links.  The following discussion will 
provide an overview of each of these features as they pertain to the worksheets and 
summary report. 
 
4.2.1 Notes in Cells 
 
To facilitate data entry and user understanding of the spreadsheet format, explanatory 
notes have been attached to many of the cells in the worksheet and summary report.  
These notes provide information to the user regarding data entry instructions, or 
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explanatory information for a single cell or range of cells.  As these notes should be 
sufficient to provide the user with instructions while using the spreadsheets, individual 
cell instructions will not be repeated in detail here.  The cells containing notes are 
indicated on the screen by a red dot in the upper right corner of the cell.  Until the user is 
familiar with data entry in the spreadsheet forms, it is suggested that the user display the 
cell notes on the screen while using the worksheets.  Instructions for displaying cell notes 
and opening multiple windows are provided below. 
 
4.2.2 Viewing Notes 
 
To view the notes in a cell or worksheet using Excel Version 4.0 choose Workspace 
from the Options menu and toggle the Info Window option on (it will display an X 
when it is on).  This will open an information window.  Next, select the Window menu, 
choose Arrange, select Horizontal, and click OK or press Enter.  This will display the 
Info Window tiled (horizontally) with the worksheet.  Now activate the worksheet (click 
within the worksheet) and you will be able to move from cell to cell within the worksheet 
and view any notes attached to marked cells.  The size of each of the windows may be 
adjusted by the user.  To resize a window, move the mouse pointer to the border of the 
window until the pointer changes to a double arrow.  Click the left mouse button, and 
drag the border to a new position to make the window either larger or smaller.  For 
additional information, refer to the appropriate section of your Excel manual discussing 
re-sizing and moving windows.   
 
To view notes in a cell or worksheet using Excel Version 5.0 choose Options from the 
Tools menu, pick the View file card, and toggle the Info Window option on (it will 
display an X when it is on).  Next, select the Window menu, choose Arrange, select 
Horizontal, and click OK or press Enter.  This will display the Info-Window tiled 
(horizontally) with the worksheet.  Excel 5.0 also allows you to use toolbar keys to 
access the Info-Window.  To display the Info-Window toolbar keys, choose Toolbars 
from the View menu.  Next, pick Customize and pick the Auditing menu.  Find the 
Show Info Window tool (the letter “i” within a blue circle) and click and drag it up to 
the toolbar at the top of the screen.  Release it at the desired location within the pre-set 
toolbar.  Again, select the Window menu, choose Arrange, select Horizontal, and click 
OK or press Enter.  This will display the Info-Window tiled (horizontally) with the 
worksheet. 
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4.2.3 Opening Additional Windows 
 
At times it may be useful to open additional windows to view several worksheets 
simultaneously.  To open a new window, select the Window menu, and choose New 
Window and a new window will appear.  Select the Window menu again, choose 
Arrange, and select Tiled, Vertical or Horizontal (play with these options to achieve 
your preference).  Once you have opened additional windows, you can click the mouse 
on the window you wish to activate, and page between worksheets using the icons at the 
bottom right of the window to display the worksheet of choice. 
 
4.2.4  Formulae and Named Ranges 
 
Formulae have been used extensively in the worksheets and summary report to generate 
unit cost ($/ha) and total costs of reclamation activities.  The cells containing formulae 
may not be changed without a password to disable the document protection.  In order to 
simplify the formulae and enhance the user's understanding of the formulae, named ranges 
have been used for all formulae.  Named ranges are an option that permits the user to 
assign a recognizable name to a single cell or range of cells.  As an example, Column D of 
the worksheet, titled "Area (ha)" contains only information pertaining to areas requiring 
reclamation activities, and this column has been named "Area."  These named ranges are 
then incorporated into the formulae rather than specific cell addresses.  A list of named 
ranges and corresponding cell addresses is provided below the Material Summary Report 
on each worksheet. 
 
4.2.5 Headers and Footers 
 
Headers and footers have been specified for the worksheets and summary report in the 
workbook.  These may be changed by the user if desired.  The header prints the filename 
in the upper left of the page, the title of the worksheet in the upper center of the page, and 
the date and time in the upper right of the page.  The footer prints the page number at the 
bottom center of the page.   
 
4.2.6 Linking Documents 
 
Specific cells of the summary report are linked to each worksheet in the workbook.  
These cells include the project name, reclamation permit number, disturbance category, 
and area to be reclaimed.  As this information is entered on the summary report it is 
automatically directed to individual worksheets in the workbook.  In a similar manner, 
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cells reporting the total cost of site preparation, revegetation and maintenance on each 
worksheet are linked to the summary report.  As the reclamation requirements for a 
specific disturbance category are defined, the summary report is automatically updated 
with the costs. 
 
In order to allow the user greater flexibility and minimize memory requirements, cells 
and cell ranges within the worksheets have not been linked (i.e. Master1 is not linked to 
Master2).  The user may find that linking some of the cells could be useful.  As an 
example, one could link the cells containing aerial broadcast seed and fertilizer 
application rates.  This would allow the user to change the application rates on one 
worksheet and simultaneously update the application rates reported on all linked 
worksheets. 
 
Establishing document links is very easily accomplished using the Copy and Paste Link 
commands on the Edit menu.  A password would be required to disable the document 
protection prior to establishing the document links.  For further information regarding 
linked documents, refer to the appropriate section of the Excel manual.  
 
4.3 Using the Workbook 
 
To apply the workbook spreadsheet for your own application, you will want to open the 
Excel workbook (RC993.5.xls) and then save it under a new name.  This will preserve 
the original Excel file as the template workbook, and allow you to create an identical 
copy of the workbook for data entry.  You may wish to save your new workbook under 
the mine name.  Note however, that the workbook name may not exceed eight characters 
in length. 
 
4.3.1 Saving a Spreadsheet Under a New Name 
 
To save each spreadsheet under a new name within the workbook, scroll to the Master1 
spreadsheet.  Select File, Save As, and notice the dialogue box Bound Save As will 
appear.  Click the mouse on the space under Bound Sheet Name and enter the new 
name.  Remember that because the spreadsheet is bound, you are able to select names up 
to 30 characters in length.  After you have typed in your new file name, click on OK, or 
press Enter.  As each worksheet presents data for a specific disturbance category, it may 
be 
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useful to assign spreadsheet names that correspond to the disturbance category (i.e. 
Master1 becomes dumptop.xls, Master2 becomes millarea.xls, Master3 becomes 
roads.xls, tailings.xls, etc.).  Renaming the worksheets will not affect any of the links 
between the worksheets. 
 
4.3.2 Saving and Exiting the Workbook 
 
To save the workbook, select File, Save Workbook; Excel will save each of the files in 
the workbook.  To exit the workbook, select File, Close Workbook. 
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